
Interface 

The 3ds Max Window 

Most of the main window is occupied by the viewports, where you view and work with your scene. The 

remaining areas of the window hold controls and show status information. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Application button,2. Quick Access toolbar,3. InfoCenter,4. Menu Bar,5. Main toolbar,6. Command panel 

tabs,7. Object categories (Create panel),8. Rollout,9. Ribbon 

10. Viewport navigation controls,11. Animation playback controls,12. Animation keying 

controls,13. Prompt line and status bar controls,14. MAXScript Mini Listener,15. Track bar,16. Time 

slider,17. Viewports,18. Scene Explorer 

One of the most important aspects of using 3ds Max is its versatility. Many program functions are available 

from multiple user-interface elements. For example, you can open Track View for animation control from 

the Main toolbar as well as the Graph Editors menu, but the easiest way to get to a specific object's track in 

Track View is to right-click the object, and then choose Track View Selected from the quad menu. 

You can customize the user interface in a variety of ways: by adding keyboard shortcuts, moving toolbars 

and command panels around, creating new toolbars and tool buttons, and even recording scripts into 

toolbar buttons. 

MAXScript lets you create and use custom commands in the built-in scripting language.  
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Application Button and Quick Access Toolbar 

The Application button and Quick Access toolbar provide file-handling commands. To the right of them on 

the Caption bar, the InfoCenter controls give you quick access to 3ds Max help and other learning 

resources.  

Menu Bar 

A standard Windows menu bar with typical Edit and Help menus. Special menus include: 

 Create contains commands for creating objects. 

 Modifiers contains commands for modifying objects. 

 Animation contains commands for animating and constraining objects, plus commands such as 

Bone Tools for setting up animated characters. 

 Rendering contains commands for creating output and changing the environment. 

 Customize gives you access to controls that let you customize the user interface. 

 MAXScript has commands for working with MAXScript, the built-in scripting language. 

For more information about the 3ds Max menus, see Menu Bar. 

Time Controls 

The Auto Key button turns on animation mode. The other controls navigate through time and play back an 

animation. 

Command Panel 

This collection of six panels provides handy access to most of the modeling and animation commands. 

You can "tear off" the command panel and place it anywhere you like. 

By default, the command panel is docked at the right of your screen. You can access a menu that lets 

you float or dismiss the command panel by right-clicking just above it. If it is not displayed, or you want to 

change its location and docking or floating status, right-click in a blank area of any toolbar, and choose 

from the shortcut menu. 

  Create holds all object creation tools. 

  Modify holds modifiers and editing tools. 

  Hierarchy holds linking and inverse kinematics parameters. 

  Motion holds animation controllers and trajectories. 

  Display holds object display controls. 

  Utilities holds miscellaneous utilities. 

Status Bar and Prompt Line 

These two lines display prompts and information about your scene and the active command. They also 

contain system toggles controlling selections, precision, and display properties.  

Viewports 

You can display from one to four viewports. These can show multiple views of the same geometry, as well 

as the Track View, Schematic View, and other informational displays.  

Viewport Navigation Buttons 

The button cluster at the lower-right corner of the main window contains controls for zooming, panning, 

and navigating within the viewports. See Viewport Controls. 

 

Application Menu   

The Application menu that appears when you click the Application button provides file-management 

commands. 
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 Quick Access toolbar  Click the   Application button.  Application menu 

 Keyboard  +F 

Interface 

 

NOTE:Most submenus of the Application menu fit 

onto one page. If there are more options than the 

page has room, a bar with an arrow appears at the top 

or bottom of the page, to let you scroll among the 

submenu choices. 

 

 

 

When you first open the Application menu, and when 

no other menu choice is active, the Application menu 

shows a list of files you have edited recently. The 

scene files are organized by date, and you can collapse 

or expand the list for each day, using the arrow icon at 

the right of each date’s title bar. 

Recent Documents page 

 

 
 

Scrolling arrow at the bottom of the Recent Documents page 

 

 

 

TIP:When you open the Application menu by using the keyboard 

shortcut +F, it displays the associated shortcuts for menu 

choices, so you can easily press the key for the choice you want. If 

you move the mouse instead of pressing another key, the menu 

reverts to its usual appearance, but pressing +F again restores 

the shortcut display. 

 Icon or Image display 

Click this control to display a submenu that lets you choose which 

icons to use on the Recent Documents page. 
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 Small Icons (The default.) Displays a small application icon before each file name. 

 Large Icons Displays a larger application icon before each file name. 

 Small Images Displays a small version of the viewport thumbnail image that by default is saved 

with the scene. 

 Large Images Displays a larger version of the viewport thumbnail image that by default is saved 

with the scene. 

Pinning a file to the list 

The pushpin icons let you keep a file in the recent files list. In the Recent Documents list, one of 

these icons appears to the right of each file name. 

3ds Max limits the number of files to display as Recent Documents. By default, the number is 10. 

You can change this value on the Files panel of the Customize UserInterface dialog: see Recent Files 

in File Menu. 

  If the pushpin is in its default state of off, and if you open more files than the limit (by 

default, the eleventh file), then the oldest file is removed from the list. 

  If you click the pushpin icon to turn it on, then 3ds Max won’t remove the file from the list. 

If the limit is reached, then an unpinned file is removed from the list, even if it is newer than the 

pinned file. 

If all files in the list are pinned and you reach the limit, then opening a new file does not add the 

new file to the list. 

All pages- 

 

Two buttons always appear at the bottom of the Application menu: 

Options,Exit 3ds Max 

Menu items 

NOTE:File dialogs (such as Open, Save, Save As) uniformly remember the previous path you used, and 

default to that location. 

New New All,Keep Objects,Keep Objects and Hierarchy and Reset 

Open Open, Open from Vault and Save 

Save As Save As,Save Copy As,Save Selected and Archive 

Import Import,Merge,Replace, 

 Link Revit,Link FBX,Link AutoCAD 

These last three choices open the File Link Manager. 

Export  

 Export,Export Selected,Export to DWF 

Send To Send to Maya,Send to Softimage,Send to MotionBuilder and Send to Mudbox 

_____ 

References Inherit Container,XRef Objects,XRef Scene,Manage Links and Asset Tracking 

Manage Set Project Folder 

Properties Summary Info,File Properties 
 

Quick Access Toolbar 
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The Quick Access toolbar provides some of the most commonly used file-management commands, as well 

as Undo and Redo. 

 3ds Max  Quick Access toolbar 

NOTE:As with other toolbars, you can customize the Quick Access toolbar on the Toolbars panel of the 

Customize User Interface panel. 

You can also delete a button directly from the toolbar by right-clicking it and choosing Remove From Quick 

Access Toolbar. In addition, you can add any button from theribbon by right-clicking the button and 

choosing Add To Quick Access Toolbar. 

Interface 

 New Scene-Click to begin a New scene. 

 Open File-Click to Open a saved scene. 

 Save File-Click to Save the currently open scene. 

 Undo Scene Operation-Click to undo the previous operation. Click the down-arrow to display an 

ordered list of previous operations, so you can choose the point from which to undo your work. 

See Undo/Redo. 

 Redo Scene Operation-Click to redo the previous operation. Click the down-arrow to display an 

ordered list of previous operations, so you can choose the point from which to redo your work. 

SeeUndo/Redo. 

 Project Folder-Click to open a dialog that lets you set the project folder for the current scene. 

Workspaces drop-down list-Click to open the drop-down list for managing the Workspaces feature. 

 Quick Access toolbar drop-down menu-Click to display a drop-down menu for managing Quick Access 

toolbar display. 

TIP:You can also customize the Quick Access toolbar, like any other 3ds Max toolbar, with 

the Toolbars panel of the Customize User Interface dialog. 

Customize Quick Access Toolbar: 

 [Quick Access toolbar choices] Each choice toggles display of a button on the Quick Access 

toolbar. 

 Hide/Show Menu Bar Choose this to hide or show the menu bar. 

 Show Below/Above the Ribbon Choose this to display the Quick Access toolbar either just 

below the ribbon, as a part of the ribbon, or “above” it in the default location on the Caption 

bar. 

NOTE:This option is available only when the ribbon is open using the horizontal format, and 

attaches the Quick Access toolbar to the ribbon. If you then close the ribbon 

(Customize  Show UI  Show Ribbon), the toolbar closes as well. To restore it, open the 

ribbon. 

Quick Access Toolbar Right-Click Menu 

When you right-click a button on the Quick Access toolbar, 3ds Max opens a drop-down menu with several 

choices. 
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Remove from Quick Access Toolbar-Turns off display of the button you clicked. This is the same as turning 

off its display by using the Quick Access toolbar drop-down menu. You can turn display of the button back 

on by using that same drop-down menu. 

Add Separator-Adds a separator, a vertical line (usually gray), to the right of the button. This can help 

make the toolbar more legible. 

To remove a separator, right-click it and choose Remove From Quick Access Toolbar. 

Show Quick Access Toolbar Above/Below the Ribbon-Choose this to display the Quick Access toolbar 

either just below the ribbon, as a part of the ribbon, or “above” it in the default location on the Caption 

bar. 

NOTE:This option is available only when the ribbon is open using the horizontal format, and 

attaches the Quick Access toolbar to the ribbon. If you then close the ribbon (Customize  Show 

UI  Show Ribbon), the toolbar closes as well. To restore it, open the ribbon. 

InfoCenter 

The InfoCenter gives you access to information about 3ds Max and other Autodesk products. It appears 

toward the right of the Caption bar. 

Interface 

 

Search field-Enter text to search for. 

See About_InfoCenter. 

Use the arrow to the left of the Search Field to either hide or display this field. 

 Search-After you enter text in the Search Field, click Search to find help topics and Web pages that 

contain this text. See About_InfoCenter. 

 Subscription Center-Click to access subscription services. See About InfoCenter. 

 Communication Center-Click to access the Communication Center. See About InfoCenter. 

 Favorites-Click to view the Favorites panel. See About InfoCenter. 

  Autodesk Exchange Apps-Click to open the Web page for the Autodesk Exchange applications 

store. 

 Quick Help menu-Click to access the 3ds Max help and other commonly used help files. The main 

help and the choices on this menu are available from the 3ds Max Help menu as well. 
Menu Bar 

The menu bar is located directly under the main window’s title bar. The title of each menu indicates the 

purpose of the commands on the menu. 

NOTE:File functions and related commands are available from the Quick Access toolbar and Application 

menu, which are separate from the menu bar. 

Interface 

Autodesk 3ds Max 2015 includes two menu systems. The default menu, known as the Standard menu, is 

the one you're familiar with if you've used previous versions of 3ds Max. Alternatively, you can use the 

new Enhanced menu, described in the Enhanced Menu section. 
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Common Menu Features 

The default Standard menu follows standard Windows conventions, as described in this section. The 

Enhanced menu follows the same conventions and offers additional features as described in Enhanced 

Menu. 

To open a menu from the menu bar, click its name, such as Edit or Customize. The menu opens as a list of 

commands and submenus or panels. To open a submenu, point at its name. To invoke a command, click its 

name. 

TIP:While a menu is open, you can open any other menu simply by pointing to it with the mouse; no 

further clicking is necessary. 

As an alternative to using a mouse or other pointing device, most menu names includes an underlined 

character when you hold down the  key. Pressing  + that character key opens the menu, unless 

that particular key combination is assigned to a keyboard shortcut. 

Some commands in the open menu have an underlined character as well. While the menu is open, pressing 

that character key invokes the command. While navigating menus with the keyboard, you can also use the 

arrow keys to move the highlighting and the  key to activate a command. 

An ellipsis (…) after a command name indicates that invoking the command opens a dialog. 

A right-pointing triangle after a command name indicates that pointing at the name will cause a submenu 

to open. 

If a command has a keyboard shortcut, the menu shows it to the right of the command name. 

If a menu command is an on/off toggle, such as Render Setup, and the panel is set to display text only 

(Enhanced menu only), a check mark indicates its status: When the check mark is present, the command is 

active. 

 

The Render Setup menu entry shows a check mark, 

indicating that the Render Setup dialog is open, as 

well as the keyboard shortcut: F10. 

Global Menu Search 

To search the entire 3ds Max system (menus and actions) for a particular command, press the X key with 

no menus open. This opens a small "Search All Actions" dialog at the mouse cursor location. As you enter 

the search text, a drop-down list opens from the search dialog showing matching actions. To choose an 

action, click its name. To clear the search field, click the X icon at the right end of the search box. To exit 

the search, choose a command, click outside the search interface, or press . 

Entering text in the global search field shows all matching 

actions. 

This function is also available as Search 3ds Max Commands on 

the Help panel of the Help menu in the Enhanced menu 

system. 

Enhanced Menu 

The optional Enhanced menu system features improved 

organization of the default layout, configurable display, 

detailed tooltips that link to relevant help topics, drag-and-

drop menu categories, and the ability to search for menu 

commands from the keyboard. 
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To access the Enhanced menus, open the Workspaces drop-down list on the Quick Access toolbar and 

choose Default With Enhanced Menus. For a list of the menus, seeEnhanced Menus. 

 

TIP:To toggle the Enhanced menu bar, use 

the Enhanced Menus command. The 

easiest way to access this command is with 

the global search feature: Press X on the 

keyboard to open the small Search All 

Actions dialog, then type enh. The Enhanced Menus command appears; click it to toggle the menus. 

Following is a list of functions available with the Enhanced menu system: 

 Each panel can be collapsed or expanded, whether docked or floating. When a panel is collapsed, a 

+ icon appears at the title bar's left end and a right-pointing triangle at the right end. When expanded, 

a - icon appears at its left end. To toggle a panel's state, click 

the title bar anywhere except the right end. 

In this partial view of the Modifiers menu, the Edit/Convert and 

Selection panels are collapsed, and the Spline panel is expanded. 

NOTE:3ds Max remembers the collapsed or expanded state of all 

panels when you exit the program and restores them upon 

restarting. 

 When collapsed, you can open a panel's contents as a 

submenu by pointing at the panel title bar. 

 

Poi

nti

ng at the title of a collapsed panel 

opens it as a submenu. 

 You can view each panel's 

contents as icons, text, or icons + 

text. To change a panel's view mode, 

click the icon at the right end of the 

title bar (see video, following). Each 

panel's setting is stored upon exiting the program and restored upon restarting. 

 Similarly, to view the top-level menus (Objects, Edit, and so on) as icons, text, or icons + text, right-

click anywhere on the menu bar and choose the corresponding command. When set to Show Icons 

Only, positioning a mouse over a menu icon opens a tooltip showing the menu name. This setting is 

stored upon exiting the program and restored upon restarting. 

 If the 3ds Max window isn't wide enough to display all menu titles, a scroll bar appears just below 

the menu bar. To access hidden parts of the menu bar, drag the scroll bar or click the arrows at the left 

and right ends. 
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Use the scroll bar to view hidden parts of the menu bar. 

 To view a tooltip that provides a brief description of a menu command, hover the mouse pointer 

over the command briefly. While a tooltip is visible, you can open the help to a topic about the 

command by pressing function key F1. 

 To float a menu panel or submenu, drag its title bar away from the menu in any direction. To dock a 

floating panel with another, drag it over the other panel. Then, when a blue line appears, indicating 

where the panel will dock, release the mouse button. Depending on where you position the panel 

while dragging, you can dock it above or below the host panel (see video, following). 

NOTE:A floating panel also remains in its original location on the menu. Also, all floating panels are 

saved upon exiting the program and restored upon restarting. 

 To move a floating panel or panel group, drag the bar at the top of the group. 

 To restore a floating panel group to the menus, click the icon at the right end of the bar at the top 

of the group (see video, following). 

 To search a menu for a particular command, open the menu and then use the keyboard to type 

part of the name. When you start typing, a search field opens at the top of the menu, and as you type, 

the menu shows only matching commands. To clear the search, click the X icon at the right end of the 

search box or press . 

 

Searching the Modifiers menu for commands matching "mesh" 

 When a command name is too long to fit in the allotted 

space, the center of the name is elided. The beginning and end 

of the name are shown, and the middle part is replaced by an 

ellipsis (...). 

 

 

 

 

 

The name Particle Flow Preset Manager is shortened 

with an ellipsis. 

To see how to float and dock Enhanced menu panels and change the display mode, play the following 

video. 

Standard Menus-The standard menu bar appears by default.Enhanced Menus-The Enhanced 

menu set, with icons, appears when you choose Default With Enhanced Menus from the Workspaces drop-

down list. 

 

www.a2zpapers.com
We provide GNDU question papers, PTU question papers, PU question papers, LPU question papers, GNA university question papers, PSEB question papers, HPSEB question papers, ICSE question papers and CBSE question papers.

a2zpapers.com

a2zpapers.com

a
2
z
p
a
p
e
r
s
.
c
o
m

a
2
z
p
a
p
e
r
s
.
c
o
m

a2zpapers.com

../../../../../../3dmax%20help/index.html#!/url=./files3dsmaxhelp/GUID-C053E49C-CD3E-4600-9ECC-32D51D44F63C.htm
../../../../../../3dmax%20help/index.html#!/url=./files3dsmaxhelp/GUID-4C562F9F-D1D0-4BE8-AA7B-BB685D80FC58.htm
../../../../../../3dmax%20help/index.html#!/url=./files3dsmaxhelp/GUID-90D08333-ADB3-4E8C-9579-1A0A71985604.htm#SECTION_D5173BAF58EB4554834C73CB565CA9C5
../../../../../../3dmax%20help/index.html#!/url=./files3dsmaxhelp/GUID-90D08333-ADB3-4E8C-9579-1A0A71985604.htm#SECTION_D5173BAF58EB4554834C73CB565CA9C5
../../../../../../3dmax%20help/index.html#!/url=./files3dsmaxhelp/GUID-90D08333-ADB3-4E8C-9579-1A0A71985604.htm#SECTION_D5173BAF58EB4554834C73CB565CA9C5
../../../../../../3dmax%20help/index.html#!/url=./files3dsmaxhelp/GUID-CC462067-0788-4EB2-ACE9-D3897085E5F3.htm
../../../../../../3dmax%20help/index.html#!/url=./files3dsmaxhelp/GUID-CC462067-0788-4EB2-ACE9-D3897085E5F3.htm
a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com


Main Toolbar 

The main toolbar provides quick access to tools and dialogs for many of the most common tasks in 3ds 

Max. TIP:If the main toolbar is not visible, open it from the Show UI submenu. 

Interface 

 

The main toolbar, split in two for this illustration 

TIP:If the main toolbar is wider than the 3ds Max window (or even than your computer screen), you can 

pan it by dragging a gray area of the toolbar, such as below the drop-down lists. 

   Undo/Redo,  Select and Link,  Unlink Selection 

 Bind to Space Warp, 

 

 Selection Filter List 

 Select Object,  Select by Name            Selection Region Flyout 

 Window/Crossing Selection Toggle 

 Select and Move 

 Select and Rotate 

 Select and Scale 

NOTE:Right-clicking the Move, Rotate, or Scale button opens the Transform Type-In 

dialog. 

  Select and Place,NOTE:Right-clicking the Select And Place button opens 

the Placement Settings dialog, also described in Select and Place. 

 Reference Coordinate System 

 Use Center Flyout  Select and Manipulate,  Keyboard Shortcut Override 

Toggle 

 2D Snap, 2.5D Snap, 3D Snap 

 Angle Snap Toggle,  Percent Snap Toggle,  Spinner Snap Toggle 

 Edit Named Selection Sets,  Named Selection Sets 
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 Mirror, 

 Align Flyout,  Manage Layers,  Graphite Modeling Tools (Open),  Curve Editor 

(Open),  Schematic View (Open) 

 Material Editor flyout,  Render Setup,  Rendered Frame Window 

Render flyout: 

  Render Production,  Render Iterative,  ActiveShade 

 

 
Command Panel 

The command panel comprises six user-interface panels that give you access to most of the modeling 

features of 3ds Max, as well as some animation features, display choices, and miscellaneous utilities. Only 

one panel is visible at a time. To display a different panel, you click its tab at the top of the command 

panel. 

These are the panels: 

  Create panel-Contains controls for creating objects: geometry, cameras, lights, and so on. 

  Modify panel-Contains controls for applying modifiers to objects and editing editable objects 

such as meshes and patches. 

  Hierarchy panel-Contains controls for managing links in a hierarchy, joints, and inverse 

kinematics. 

  Motion panel-Contains controls for animation controllers and trajectories. 

  Display panel-Contains controls that let you hide and unhide objects, along with other display 

options 

  Utilities panel-Contains miscellaneous utility programs. 

By default, the command panel appears at the right of the 3ds Max window. You can "dock" it along other 

edges of 3ds Max window, or make it a floating panel.  

 Object Name and Wireframe Color 

The name and color fields appear at the top of all command panels other than the Create panel. On 

the Create panel, the fields are contained in a rollout. You can change an object's name or color from 

any of these locations. 
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 Create Panel-The Create panel provides the controls for creating objects. This is the first step in 

building a new scene in 3ds Max. 

 Modify Panel-From the Create panel of 3ds Max, you place basic objects in your scene, including 3D 

geometry, 2D shapes, lights and cameras, space warps, and helpers. 

 Hierarchy Panel-The Hierarchy panel provides access to tools to adjust the hierarchical linkage 

between objects. 

 Motion Panel-The Motion panel provides tools to adjust the motion of the selected object. 

 Display Panel-The Display panel provides access to tools that control the display of objects in the 

scene. 

 Utilities Panel-The Utilities panel gives you access to a variety of utility programs. 
Create Panel 

 
The Create panel provides the controls for creating objects. This is the first step in building a new scene 

in 3ds Max. 

 Command 

panels   Create panel 

 

Villa with a swimming pool was 

created using a variety of 

geometry. 

Most likely, you will continue to 

add objects throughout an entire 

project. For example, when it is 

time to render a scene you might 

need to add more lights. 

The Create panel groups the 

kinds of objects you create into 

seven categories. Each category 

has its own button. Within each 

category there can be several 

different subcategories of 

objects. A drop-down list lets you choose among object subcategories, and each kind of object has its own 

button, which you click to begin creation. 

These are the categories of objects that the Create panel provides: 

  Geometry-Geometry is the renderable geometry of the scene. There are geometry primitives 

such as Box, Sphere, Pyramid, and more advanced geometry such as Booleans, Lofts, and particle 

systems, as well as Doors and Stairs, AEC Extended objects such as Terrain and Railing. 

  Shapes-Shapes are splines or NURBS curves. They have only one local dimension, although they 

can exist in 2D space, such as a Rectangle shape, or 3D space, such as a Helix. 

You can give shapes a thickness so they will render, but primarily you use them for constructing other 

objects such as Lofts, or for motion trajectories. 
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  Lights-Lights illuminate the scene and improve its realism. There are several kinds of lights, 

each of which models different types of lighting in the real world. 

  Cameras-Camera objects provide a view of the scene. The advantages of cameras over the 

views in the standard viewports are that cameras have controls similar to real-world cameras, and that 

you can animate a camera's position. 

  Helpers-Helper objects are aids to constructing a scene. They help you position, measure, and 

animate the scene's renderable geometry. 

  Space Warps-Space warps produce various kinds of distortions in the space surrounding other 

objects. Some space warps are meant especially for use with particle systems. 

  Systems-Systems combine objects, controllers, and hierarchies to provide geometry associated 

with some kind of behavior. Also contains Sunlight and Daylight systems that simulate sunlight in your 

scenes. 

Rollouts 

 

A rollout is an area on command panels and dialogs that you can expand (roll 

out) or collapse (roll in) to manage screen space. In the preceding illustration, 

the Keyboard Entry rollout is collapsed, as indicated by the downward-pointing 

arrows (or + sign), and the Parameters rollout is expanded, as indicated by the 

upward-pointing arrows (or − sign). 

To open and close a rollout: 

 Click the rollout title bar to toggle between expanded and collapsed. 

To move a rollout: 

 You can move a rollout in the expanded or collapsed state. To move the rollout, drag the rollout 

title bar to another location on the command panel or dialog. As you drag, a semi-transparent image of 

the rollout title bar follows the mouse cursor. When the mouse is positioned over or near a qualifying 

position for the rollout, a blue, horizontal line appears at the position where the rollout will drop when 

you release the mouse button. 
he Ribbon 

The ribbon takes the form of a toolbar that can dock in a horizontal or vertical configuration or float in a 

vertical configuration. The toolbar contains these tabs: 

 Modeling, Freeform, Selection, Object  Paint and Populate 

 

Maximized ribbon in horizontal orientation (partial view)    Each tab contains a number of panels whose 

presence, in general, depends on the context. For example, the Selection tab contents vary with the active 

sub-object level. You can use a right-click menu to determine which panels appear, and you can also tear 

off panels so they float independently on the interface. You can adjust the panel size horizontally by 

dragging either end, and when you make it smaller, the panels adjust automatically to fit. The same 

controls that were previously available directly then become available from drop-down menus. 
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The first tab on the ribbon is the Modeling tab, and its first panel, Polygon Modeling, provides a subset of 

Modify panel tools: sub-object level (Vertex, Edge, Border, Polygon, Element); stack level, preview options 

for sub-object selection, and more. At any time you can show or hide any available panel with the right-

click menu. 

NOTE:Most tools on the ribbon have two-part tooltips; the first part contains a brief description of the 

tool, and sometimes lists important options. The second part, when available, describes how to use the 

tool, often with an illustration, and with certain tools lists secondary options.Also, some tooltips have an 

embedded video, or ToolClip, that uses motion to show how to use the tool. These are indicated by the 

text “Press Y for video.” To restart the video, press Y again. 

Definations:- 

 Using the Ribbon-The ribbon interface takes the form of a highly customizable, context-sensitive 

toolbar containing these tabs: Modeling, Freeform, Selection, Object Paint, and Populate. Each tab 

comprises a number of panels and tools whose availability can depend on the context. 

 Ribbon Controls-Most ribbon-configuration controls are available from right-click menus. This topic 

details these controls as well as others for customizing the ribbon setup. 
 

Viewport Navigation 

At the right end of the status bar are the buttons that control the display and navigation of the viewports. 

Some of the buttons change for camera and light viewports. The Field Of View button 

changes for Perspective viewports. 

The state of the navigation-button flyouts for all viewport types is saved in the [Performance] section of 

the 3dsmax.ini file. 

Viewport Navigation Controls 

The navigation controls depend on the active viewport. Perspective, orthographic, camera, and light 

viewports all have specialized controls. The term “orthographic” refers to User viewports as well as 

viewports like Top, Front, and so on. The Zoom Extents All flyout and Maximize Viewport Toggle, available 

in all viewports, are included with the Perspective and orthographic viewport controls. 

Many of these controls are modal, meaning they stay on for repeated use. The buttons highlights when on. 

To turn them off, press , right-click in a viewport, or choose another tool. 

 2D Pan Zoom Mode 

Controls Available in All Viewports 

 Zoom Extents All, Zoom Extents All Selected,  Maximize Viewport Toggle 

Perspective and Orthographic Viewport Controls 

Perspective and Orthographic Viewport Controls,  Zoom,  Zoom All,  Zoom Extents 

/ Zoom Extents Selected 

  Field-of-View Button (Perspective) or Zoom Region,  Pan View,  Walk Through and  Orbit, 

Orbit Selected, Orbit Sub-Object 

Camera Viewport Controls 

 

Camera Viewport Controls,    Dolly Camera, Target, or Both,  Perspective 
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 Roll Camera,  Field-of-View Button,  Truck Camera,  Walk Through,  Orbit/Pan Camera 

Light Viewport Controls 

 

Light Viewport Controls,    Dolly Light, Target, or Both,  Light Hotspot 

 Roll Light,  Light Falloff,  Truck Light and  Orbit/Pan Light 

 Pan/Truck, 2D Pan Zoom, and Walkthrough Flyout-In Perspective and Camera viewports, this flyout 

lets you choose between Walkthrough navigation, 2D Pan Zoom, or Pan/Truck. 

 Truck and 2D Pan Zoom Flyout-In Spotlight viewports, this flyout lets you choose between Pan 

navigation or 2D Pan Zoom mode. 

 2D Pan Zoom Mode-In 2D Pan Zoom Mode, you can pan or zoom a viewport without changing the 

rendering frame. 

 Controls Available in All Viewports-The topics in this section describe viewport controls that are 

available in all viewports: orthographic, perspective, camera, and spotlight or directional light. 

 Walkthrough Controls for Perspective and Camera Viewports-The topics in this section describe 

Walkthrough controls, which are available for perspective and camera viewports. 

 Perspective and Orthographic Viewport Controls-Perspective, orthographic, user, grid, and shape 

viewports all share the same viewport controls. 

 Camera Viewport Controls-A Camera viewport shows the view from a camera, looking in the 

direction the camera is aimed. 

 Light Viewport Controls-A Light viewport shows the view from a spotlight or directional light, 

looking at its target.Animation and Time Controls 

The main animation controls are found at the bottom of the program window, between the status bar and 

the viewport navigation controls, along with the time controls for animation playback within viewports. 

Two additional important animation controls are 

the time slider and track bar, found on the status 

bar to the left of the main animation controls. 

 

The time slider and track bar 

Animation Controls 

Auto Key Animation Mode and Set Key Animation Mode,  Selection List 

 Default In/Out Tangents For New Keys,  Key Filters,  Go To Start,  Previous 

Frame/Key 

  Play/Stop,  Next Frame/Key,  Go To End,  Current Frame (Go To Frame) 

Time Controls 

 Key Mode,  Time Configuration 
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DEfinations 

 Auto Key Animation Mode-The Auto Key button toggles the keyframing mode called Auto Key. 

While Auto Key is on, changes to objects’ position, rotation, and scale are automatically keyframed 

(recorded). When Auto Key is off, these changes are applied to frame 0. 

 Set Key Animation Mode-Set Key Animation mode allows you to create keys for selected objects 

individual tracks using a combination of the Set Keys button and Key Filters. Unlike Auto Key, Set Key 

mode gives you control over what you key and when. It allows you to pose a character (or transform 

any object) and then if you like it, use that pose to create keys. If you move to another point in time 

without keying, your pose is discarded. Set Key also works with object parameters. 

 Default In/Out Tangents For New Keys-This flyout provides a quick way to set a default tangent 

type for new animation keys created with Set Key Mode or Auto Key Mode. You can also access 

thetangent types from the Key Info (Basic) rollout and the Curve Editor's Key Tangency toolbar. 

 Go To Start-Go To Start moves the time slider to the first frame of the active time segment. The 

active time segment is set in the Start Time and End Time fields of the Time Configuration dialog. 

 Previous Frame/Key-Previous Frame moves the time slider back one frame. 

 Play/Stop-The Play button plays the animation in the active viewport. If you click another viewport 

to make it active, the animation continues playing in that viewport. When the animation is playing, 

the Play button becomes a Stop button. The Play button is a flyout for playing only the animation of 

selected objects. 

 Next Frame/Key-Next Frame moves the time slider ahead one frame. 

 Go To End-Go To End moves the time slider to the last frame of the active time segment. The active 

time segment is set in the Start Time and End Time fields of the Time Configuration dialog. 

 Current Frame (Go To Frame)-Current Frame displays the number or time of the current frame, 

indicating the position of the time slider. You can also enter a frame number or time in this field to go 

to that frame. 

 Key Mode-Key Mode lets you jump directly between keyframes in your animation. By default, Key 

Mode uses the keys visible in the track bar below the time slider. Other options are available on 

the Time Configuration dialog in the Key Steps group. 

 Time Configuration-The Time Configuration dialog provides settings for frame rate, time display, 

playback, and animation. You use this dialog to change the length of your animation, or stretch or 

rescale it. You also use it to set the start and end frames of the active time segment and your 

animation. 
 

Status Bar Controls 

The 3ds Max window contains an area at the bottom for prompt and status information about your scene 

and the active command. The coordinate display area lets you type transform values, and on the left, a 

two-line interface provides a shortcut to the MAXScript Listener. 

Time Slider and Track Bar 

 

Time Slider 

 Open Mini Curve Editor 

Click to display a version of the Track View Curve Editor in place of the time slider and track bar. 
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When curves are displayed, you can click the Close button at upper left to return to a view of the 

time slider and track bar. 

Status Bar 

 

Definations 

 Prompt Line-The prompt line, located at the bottom of the window under the status line, provides 

ongoing feedback, based on the current cursor position and the current program activity. When you 

don’t know what to do next, look down here for instructions. 

 MAXScript Mini Listener-The MAXScript Mini Listener is a single-line view of the contents of 

the MAXScript Listener window. 

 Status Line-The status line displays the number and type of object or objects selected. The status 

line is located at the bottom of the screen, just above the prompt line. 

 Time Slider-The time slider works in conjunction with the track bar to allow you to view and edit 

your animation. The slider itself shows the current frame and lets you move to any frame in the active 

time segment by dragging. Right-clicking the slider bar opens the Create Key dialog, which lets you 

create transform keys without keyframing. 

 Track Bar-The track bar provides a timeline showing the frame numbers (or appropriate display 

units). It provides a quick alternative to Track View for moving, copying, and deleting keys, and 

changing key properties. Select an object to view its animation keys on the track bar. The track bar 

also displays keys for multiple selected objects. 

 Isolate Selection Toggle-The Isolate Selection toggle on the status bar toggles turns isolation either 

on or off. 

 Selection Lock Toggle-Selection Lock Toggle turns selection locking on and off. Locking the selection 

prevents you from inadvertently selecting something else in a complex scene. 

 Coordinate Display-The Coordinate Display area shows the position of the cursor or the status of a 

transform and lets you enter new transform values. 

 Adaptive Degradation Button-Turns adaptive degradation on or off. See Adaptive Degradation in 

Viewports for more information. 

 Grid Setting Display-The grid setting display shows the size of one grid square. 

 Time Tag-Time tags are text labels that you can assign to any point in time in your animation. 

 

MAXScript Mini Listener 

The MAXScript Mini Listener is a single-line view of the contents of the MAXScript Listener window. 

 Click the tag bar, to the left of the status and prompt lines, and drag it to the right to display the 

MAXScript Mini Listener. 

The MAXScript Listener window is divided into two panes: one pink, and one white. The pink pane is the 

MacroRecorder pane. When the MacroRecorder is enabled, everything that is recorded is displayed in the 

pink pane. The pink line in the Mini Listener shows the latest entry into the MacroRecorder pane. 

The white pane is the Scripter window where you can create scripts. The last line you type in the white 

area of the Listener will appear in the white area of the Mini Listener. Use the arrow keys to scroll the 

display in the Mini Listener. 
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You can type directly into the white area of the Mini Listener, and the command executes in the viewports. 

Right-click either of the Mini Listener lines to open the floating MAXScript Listener window. It will also 

display a list of the last 20 commands recorded. You can choose any of these commands and 

press  to execute them. 

For more information about the MAXScript Listener window, as well as about creating scripts, see the 

MAXScript Help: choose Help  MAXScript Help. 

Procedures 

Example: To create a sphere using the Mini Listener: 

1. Click the tag bar at the left end of the status bar, and drag it to the right to expand the Mini 

Listener. 

2. In the Scripter (white, lower) line, type sphere radius: 50 and press . 

A sphere appears in the viewports. 

Example: To redo a command using the Mini Listener: 

1. Click the tag bar at the left side of the status bar, and drag it to the right to expand the Mini 

Listener. 

2. Right-click the Mini Listener and choose Open Listener Window. 

3. From the MacroRecorder menu, choose Enable. 

4. Using the command panel, create a sphere in the perspective viewport. 

5. Convert the sphere to an Editable Mesh. 

6. Delete the sphere. 

7. Make a box. 

8. Right-click the MacroRecorder (pink, upper) line and choose macros.run "Modifier Stack" 

"Convert_to_Mesh" from the list. The box has been collapsed to an editable mesh. 

Example: To make a script and add it to a toolbar: 

For this very simple example, you’ll make a script that collapses an object to an editable mesh, and then 

create a toolbar icon to run the script. 

1. Right-click the Mini Listener, and choose Open Listener Window. 

2. From the MacroRecorder menu, choose Enable. Close the listener window. 

3. Create a box in the Perspective viewport. 

4. Right-click the box and choose Convert to:  Editable Mesh from the quad menu. 

5. Left-click in the MacroRecorder line. 

The MacroRecorder line goes blank because the cursor goes to the last line. 

6. Press the  (up-arrow) key on the keyboard to move up the list of recorded command scripts. 

7. Click and highlight the macros.run "Modifier Stack" "Convert_to_Mesh" line. 

Highlight the command script as you would highlight a line of text in a text editor by clicking at the start 

of the line and dragging along the entire length. 

8. Click and drag the highlighted script from the Mini Listener to a toolbar. 

Interface 
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MacroRecorder Line-The pink, upper line displays the last thing recorded by the MacroRecorder. If the 

MacroRecorder is not enabled, nothing will appear in this line. 

Scripter Line-The white, lower line displays the last entry typed into the Scripter window. You can type 

directly into this line and execute the commands in the viewports. 

History List-Right-clicking either of the Mini Listener lines displays a history of the last twenty commands 

recorded by the Macro Recorder (provided it has been enabled). Click any of these commands to execute 

them in the viewports. 

Open Listener Window-Right-clicking either of the Mini Listener lines displays a dialog that allows you to 

open the MAXScript Listener window. You can also open the Listener using the Utilities panel  MAXScript 

rollout. You can display the Listener window in a viewport by clicking or right-clicking the Point-Of-View 

(POV) viewport label, then on the POV viewport label menu, choosing Extended Viewports  MAXScript 

Listener. 

NOTE:When you open the MAXScript Listener in this way, and then change the viewport POV, 3ds 

Max opens the Listener in a window of its own. 

Track Bar 

The track bar provides a timeline showing the frame numbers (or appropriate display units). It provides a 

quick alternative to Track View for moving, copying, and deleting keys, and changing key properties. Select 

an object to view its animation keys on the track bar. The track bar also displays keys for multiple selected 

objects. 

 The track bar is located below the viewports, between the time slider and the status bar. 

 

The displayed keys use color coding, so you can easily 

determine what kind of key exists at that frame. 

Position, rotation and scale keys are red, green, and 

blue, respectively, and non-transformational keys such as modifier parameters are gray. You can customize 

the colors in the Customize User Interface dialog, and depends on the selected/unselected state of the key. 

The frame indicator is a similar bar displayed in blue. 

A key on the track bar can represent any number of animated parameters for the selected objects. 

Transformations, modifiers, and animated material parameters can all have keys at a particular frame. 

To display a list of all keyed values for a key on the track bar, right-click the key. Choose a key type from 

the right-click menu to display its key properties dialog. Delete keys and filter the track bar display using 

options on the right-click menu. 

The track bar right-click menu contains a submenu that lists any procedural controllers (list controllers, 

expression, reactors, springs, noise, and so on) assigned to the current object selection. If you select one of 

the controllers from the submenu, the properties dialog for that controller displays in a modeless dialog. 

The track bar can display a waveform (.wav file) assigned to the Sound track in Track View. To display this 

feature, right-click the track bar and choose Configure  Show Sound Track (this command is also 

available on the Animation menu  Sound panel). 

You can modify the active time segment by pressing  and  while dragging the track bar. 

Hold  (the left mouse button) to slide the start of the range,  (the right mouse button) to slide the end 

of the range, and  (the middle mouse button) to change both the start and end frames together. A 

tooltip at the cursor and a status bar message will indicate the range you are setting. 
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NOTE:While  (Auto Key) is active, the time slider background is highlighted red, to indicate that 3ds 

Max is in automatic keyframing mode. 

You can expand the track bar to show curves. Click  (Open Mini Curve Editor) at the left end of the track 

bar. The time slider and track bar are replaced with the controller and key windows and the Track View 

toolbars. You can resize the track bar window by dragging the border between the menu bar and the 

toolbars (do this in an empty toolbar area). 

 

Track bar displaying curves 

NOTE: How you zoom and pan in the Mini Curve Editor depends on which interaction mode, 3ds Max or 

Maya, is active. 

Procedures 

To select keys on the track bar: 

1. Click a key to select it. 

2. Drag a window around a selection of keys to region-select multiple keys. 

If the track bar right-click menu  Configure  Show Selection Range option is on, when you select 

multiple keys, the range of the selected keys is shown in the selection range bar at the bottom of the 

track bar. You can then scale the selected keys proportionally by dragging either end of the selection 

range bar, or move the keys by dragging the center of the bar. 

To move or clone keys on the track bar: 

While keys are moved or cloned, small lines on the track bar mark the original position of the keys. All keys 

at a particular frame are moved simultaneously using the following procedures. 

1. Drag a key selection to move it in time. 

2. Hold down , then drag a key to clone it. 

You can +drag to clone a selection of multiple keys. 

3. Right-click to abort a move or clone operation. 

To move a single key from a frame with multiple keys: 
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If, for example, a frame has both a transform key and a material key for the selected object, and only the 

transform key must move, open the Transform Properties dialog and use the Time parameter to move the 

transform key. 

1. Right-click a key on the track bar and choose a key on the pop-up window key list. 

A Key Properties dialog opens. 

2. Change the Time parameter in the Key Properties dialog. 

The key slides along the track bar to a new location. 

To delete keys on the track bar: 

1. Make a key selection on the track bar and press . 

All selected keys are deleted. 

2. Make a key selection on the track bar, right-click anywhere on the track bar to display the track bar 

menu, and then choose Delete Selected Keys on the pop-up window. 

All selected keys are deleted. 

To delete a single key type on a frame with multiple keys: 

An object can have many keys for different animated parameters at a particular frame. Use this procedure 

to delete a key for a single parameter. 

1. Right-click over a selected or unselected key on the track bar. 

A pop-up window displays. 

2. Move the mouse over Delete Key, then choose a key to delete in the submenu. 

To change the length of the active time segment: 

You can change the animation length using track bar. 

 Hold down +  and drag on the track bar: 

 With  (the left mouse button) to change the active time segment's start frame. 

 With  (the middle mouse button) to change the active time segment start and end frames 

simultaneously. 

 With  (the right mouse button) to change the active time segment end frame. 

To hide or show the track bar: 

 Choose Customize  Show UI  Show Track Bar. 

This menu item is a toggle: a check mark shows that the track bar is currently displayed. 

To show curves on the track bar: 

 At the left-hand side of the track bar, click  (Open Mini Curve Editor). 

The track bar keys are replaced with a menu bar, toolbars and the controller and key windows. 

Interface 

Track Bar 

 

 Make an object selection in the viewports to 

display the object’s keys on the track bar. 

 Selected transformation keys are white; 

unselected keys are other colors. 
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 Drag from an empty area of the track bar to region-select keys. 

 Drag a key to move it in time. 

 Hold down  and drag a key to clone it. 

 Hold down +  and drag the track bar to change the active time segment; that is, the 

animation range displayed on the track bar. The effect differs depending on the mouse button you drag 

with, as follows: 

 Drag with  (the left mouse button) to change the active time segment's start frame. 

 Drag with  (the middle mouse button) to change the active time segment start and end 

frames simultaneously. 

 Drag with  (the right mouse button) to change the active time segment end frame. 

 Right-click to abort a move or clone operation. 

 During a move or clone operation, short, vertical, gray lines represent the original key locations. 

 The cursor changes to a cross when over unselected keys. 

 The cursor changes to a two-sided arrow over selected keys, signifying a move operation is 

possible. 

 Right-click anywhere on the track bar to display the track bar right-click menu. Right-click over a key 

to access its keyed values from the right-click menu, as well as other track bar-related commands. 

 Click  (Open Mini Curve Editor) to expand the track bar. When the track bar is expanded it 

displays the Track View menu, toolbars, controller and key windows. You can hide or unhide UI 

Elements such as scroll bars as well when this is expanded. 

Track bar menu 

Right-click a key on the track bar to display the track bar menu. 

 

[list of keys]-Displays the object name and key type for all keys at the current 

position. Choose any of the keys in the list at the top of the track bar menu to 

display a key properties dialog. For more information on this dialog, see Key Info 

(Basic) and Key Info (Advanced). 

 A key with a check next to the name indicates the key is shared with 

other instances in the list. Two selected objects might share the same 

Twist modifier, for example. 

 The list displays keys for all selected objects. If there are more than 10 keys, then the list turns 

to a submenu under Key Properties in the track bar menu. 

 If there is no key properties dialog for a key type, the key is unavailable. 

Controller Properties-Displays a submenu that contains a list of all of the procedural controllers (list 

controllers, expression controllers, reactors, springs, noise, and so on) assigned to the object selection. 

Delete Key-Displays a submenu similar to the key list at the top of the track bar menu. Choose a key type 

to delete an individual key, or choose All to delete all of the keys. 
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Keys do not need to be selected on the track bar in order to use Delete Key. Keys are deleted from 

the track bar key over which you right-clicked. 

Delete selected keys-Deletes the keys selected on the track bar. If no keys are selected, this option is unavailable. 

Filter-Displays a Filter submenu. Choose a filter to filter the track bar display; showing only transformation 

keys, for example. 

Right-click anywhere on the track bar, place the cursor over Filter in the track bar menu to display 

the Filter submenu, then choose filter settings. The settings 

determine which keys appear on the track bar. 

 

The upper section of the Filter submenu lets you choose one of the 

following: 

 All Keys Displays all keys. 

 All Transform Keys Displays only keys for position, 

rotation and scale. 

 Current Transform Displays only keys that use the 

currently selected transform: position, rotation or scale. 

 Object Displays object modifier keys. Excludes transformation and material keys. 

 Material Displays material keys for the material assigned to the selected objects. 

The lower section of the Filter submenu lets you toggle each of the following, for any combination 

of these filter options: 

 Keyable Tracks Only Controls the display of keyable tracks on the track bar. 

 Parameter Collector Keys Filters keys related to the Parameter Collector. 

 Layer Controller - Active Only This filter lets you see only the keys of the active Layer controller. 

Otherwise, you see all the keys of all Layer controllers. 

 Layer Controller - Hide Weights This filter hides the weight parameter keys of a Layer 

controller from the track bar. 

 List Controller - Active Only This filter lets you see only the keys on the active control in a List 

Controller. Otherwise, you see all the keys on all the controls. 

 List Controller - Hide Weights This filter hides the weight parameter keys of a List Controller 

from the track bar. 

Configure 

Displays a submenu that lets you change the track bar display and behavior. 

 

The Configure options are: 

 Show Frame Numbers Displays frame numbers in the track bar. 

 Show Selection Range Displays a selection range bar below the track bar, whenever multiple 

keys are selected. 

You can scale all selected keys by dragging either end of the selection range. This lets you 

change the length of an animation segment while maintaining the relative distance between 

animation keys. You can also move the selected keys in time by dragging the selection range 

bar. 

www.a2zpapers.com
We provide GNDU question papers, PTU question papers, PU question papers, LPU question papers, GNA university question papers, PSEB question papers, HPSEB question papers, ICSE question papers and CBSE question papers.

a2zpapers.com

a2zpapers.com

a
2
z
p
a
p
e
r
s
.
c
o
m

a
2
z
p
a
p
e
r
s
.
c
o
m

a2zpapers.com

../../../../../../3dmax%20help/index.html#!/url=./files3dsmaxhelp/GUID-643D8571-328F-4D50-B2C5-072F083A3FC9.htm
../../../../../../3dmax%20help/index.html#!/url=./files3dsmaxhelp/GUID-ACAD407C-B079-4DAB-9DD0-6C8DC22389EF.htm
../../../../../../3dmax%20help/index.html#!/url=./files3dsmaxhelp/GUID-ACAD407C-B079-4DAB-9DD0-6C8DC22389EF.htm
../../../../../../3dmax%20help/index.html#!/url=./files3dsmaxhelp/GUID-ACAD407C-B079-4DAB-9DD0-6C8DC22389EF.htm
../../../../../../3dmax%20help/index.html#!/url=./files3dsmaxhelp/GUID-ACAD407C-B079-4DAB-9DD0-6C8DC22389EF.htm
a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com


 Show Sound Track Displays the waveform (.wav file) that is assigned to the sound object in 

Track View. 

 Snap to Frames Keys snap to frame numbers when moved. If turned off, you can place keys 

between frames. 

Go to Time 

Moves the time slider to the cursor position. 

Right-click anywhere on the track bar, and then click Go To Time. 
Time Slider 

The time slider works in conjunction with the track bar to allow you to view and edit your animation. The 

slider itself shows the current frame and lets you move to any frame in the active time segment by 

dragging. Right-clicking the slider bar opens the Create Key dialog, which lets you create transform keys 

without keyframing. 

 Status line  Time Slider 

 
When Set Key is off, you can copy selected objects' transform data from a source frame to a destination 

frame, creating a key at the latter, by right-button dragging the time slider from the source to the 

destination. Set parameters as necessary on the Create Key dialog, then click OK. 

In Set Key mode, holding down  (the right mouse button) and dragging the time slider allows you to 

move a pose in time without losing it in the viewport. 

To move one frame back or forward, click the arrow on the left or right side of the time slider, respectively. 

Or simply click anywhere on the time line to go to that time. InKey Mode, clicking an arrow jumps to the 

adjacent key. 

The Track View Key window displays a time slider as well. The movement of the two time sliders is 

synchronized. Moving the time slider in the Track View window also moves the time slider below the 

viewports and vice versa. 

Procedures 

To toggle the time slider, do the following: 

 On the Enhanced menu  Animation menu  Timeline panel, click Show Time Slider. 

To move to a specific frame in the animation, do one of the following: 

 Drag (scrub) the time slider right or left until the frame number is displayed on the time slider. 

 Type the frame number into the current frame field in the time controls and press . 

 

 Click in the empty track to either side of the time slider. The time slider will jump to your cursor 

position. This is faster than dragging the time slider. 

To move forward or back by one key, do one of the following: 

By default, Key Mode is off, and these controls move a frame at a time. To move between keys, click the 

Key Mode Toggle button; this turns on Key Mode. When Key Mode is on, the button looks like this:  

 Click the < or > button at either end of the time slider. 

 Press the < or > key on the keyboard. 
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   When Key Mode is off, click the Next Frame or Previous Frame button in the time controls. 

  When Key Mode is on, click the Next Key or Previous Key button in the time controls. 

To move to the first or last frame of the active time segment: 

 Use the time control buttons  (Go To Start) or  (Go To End). 

To display SMPTE time code on the time slider: 

 In the time controls, click  (Time Configuration), and then under Time Display, choose SMPTE. 

To display subframes on the time slider: 

 In the time controls, click  (Time Configuration), and then under Time Display choose 

Frames:TICKS or MM:SS:TICKS. 

Each frame is divided into subframes. 

To use the time slider to adjust animation, do one of the following: 

 To copy a pose from one frame to another, with Auto Key on or off, and Set Key off, right-click the 

time slider and drag to a new location. 

The Create Key dialog appears with Source Time set to the frame you were on when you right-clicked, 

and Destination Time set to the frame to which you moved the time slider. Toggle the Position, 

Rotation, and Scale checkboxes as necessary and then click OK to create a key at the destination frame 

for the pose at the source frame. 

 In Set Key mode, if you have posed your character on the wrong frame, right-click and drag the time 

slider. The pose is moved in time to the new time slider position. Click the Set Key button to set the 

keys. 

To scrub the animation with the mouse but without dragging: 

1. Open Customize User Interface and on the Keyboard panel, click in the Action list and then 

press T to jump to the T section. Scroll down to find Time Slider Capture Toggle and click it. 

2. Click the Hotkey field and then press a keyboard combination to assign as a keyboard shortcut; for 

instance, +T. Click the Assign button. 

3. Close the Customize User Interface dialog and then press your hotkey for Time Slider Capture 

Toggle. 

4. Move the mouse left and right without pressing any buttons. 

The time slider moves in tandem with the mouse. 

5. To exit this mode, press the hotkey again or click any mouse button. 

Interface 

By default, the active time segment is from frame 0 to frame 100. The slider displays time in 

frames, SMPTE numbers, or other measurements, depending on the current setting in the Time 

Configuration dialog. 

The slider bar displays the current frame, followed by a slash (/), followed by the total frames in the active 

time segment. For example 25/100 means frame 25 of 100 frames. The current frame also appears in the 

current frame field. If animation exists in the scene, it's played back as you drag the time slider. 

The buttons at the left and right ends of the time slider move the animation one frame backward and 

forward, respectively, like the Previous Frame and Next Frame buttons in the time controls. If Key Mode is 

on, these buttons duplicate the Previous Key and Next Key buttons instead. 

www.a2zpapers.com
We provide GNDU question papers, PTU question papers, PU question papers, LPU question papers, GNA university question papers, PSEB question papers, HPSEB question papers, ICSE question papers and CBSE question papers.

a2zpapers.com

a2zpapers.com

a
2
z
p
a
p
e
r
s
.
c
o
m

a
2
z
p
a
p
e
r
s
.
c
o
m

a2zpapers.com

../../../../../../3dmax%20help/index.html#!/url=./files3dsmaxhelp/GUID-71DEAF46-80B6-47D8-8F58-F103CECEE1F5.htm
../../../../../../3dmax%20help/index.html#!/url=./files3dsmaxhelp/GUID-39D8B2E9-6113-4D50-AF84-1ED255580911.htm
../../../../../../3dmax%20help/index.html#!/url=./files3dsmaxhelp/GUID-9473CAF3-AF73-4127-A98C-58ACEF01ACAC.htm
../../../../../../3dmax%20help/index.html#!/url=./files3dsmaxhelp/GUID-9473CAF3-AF73-4127-A98C-58ACEF01ACAC.htm
../../../../../../3dmax%20help/index.html#!/url=./files3dsmaxhelp/GUID-9473CAF3-AF73-4127-A98C-58ACEF01ACAC.htm
../../../../../../3dmax%20help/index.html#!/url=./files3dsmaxhelp/GUID-3642193A-F102-4609-8A2B-8B458647E076.htm
../../../../../../3dmax%20help/index.html#!/url=./files3dsmaxhelp/GUID-DF2FD675-FD07-44A5-8BAA-24906662AC05.htm
a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com


Key Mode can jump to all the keys or only the transform keys, depending on the Key steps setting in the 

Time Configuration dialog. 

TIP: With one or more objects selected, right-click the slider bar to open the Create Key dialog. This lets 

you create Position, Rotation, or Scale keys without using Auto Key. It also lets you copy keys easily from 

one frame to another. 
 

Viewport Controls 

You can choose different views to display in these four viewports as well as different layouts from 

the Viewport Label Menus. 

NOTE:This section covers general configuration of the viewports. To learn how to use the other viewport 

controls, such as zooming and panning the view, see Viewing and Navigating 3D Space. 

Viewport Layouts 

You can choose from layouts other than the default configuration. To choose a different layout, click or 

right-click the General viewport label ([+]), and from the General viewport label menu, choose Configure 

Viewports. Click the Layout tab of the Viewport Configuration dialog to choose an alternative layout. 

 

Typical viewport layout 

Also, the Viewport Layouts feature lets you set up any number of different viewport layouts in a session 

and switch quickly among them. 

NOTE:The viewport layout is saved with your MAX scene file. 

TIP:You can change the default viewport layout by saving a maxstart.max file with the desired viewport 

configuration and placing it in the /defaults folder . 

Active Viewport Borders 
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When multiple viewports are visible, one viewport, marked with a highlighted border, is always active. This 

is where commands and other actions take effect. For example, press +W to toggle between 

maximizing the active viewport and viewing all available viewports. 

Only one viewport at a time can be active. Other viewports are for observation only; unless disabled, they 

simultaneously track actions taken in the active viewport. When Auto Key or Set Key is on, the active 

viewport border changes to red. 

In general, a viewport becomes active as you work in it. You can move an object in one viewport, and then 

drag the same object in another viewport to continue the move. To activate a viewport without changing 

the selection, right-click it. If you left-click a viewport, the viewport is activated and whatever you click is 

selected, or, if you click an empty area, everything is deselected. You can restore previous selections with 

Undo ( +Z). 

Switching Viewports When Maximized 

When a multi-viewport layout is active and a viewport is maximized (toggle with +W), you can switch 

to other viewports in the layout by first pressing and holding the  Windows key (sometimes labeled 

"Start") and then pressing and releasing the  key. This opens an overlay interface for switching to a 

different viewport: 

 

Overlay interface for changing the maximized viewport 

At this point, the next available viewport is highlighted. You can change the highlighting by 

pressing  repeatedly; releasing the  key at any time maximizes the highlighted viewport. 

Alternatively, point to the desired viewport and click the mouse button. 

Viewport Labels and Viewport Label Menus 

Viewports are labeled in the upper-left corner. The labels show current settings such as the point of view 

and rendering mode. Click or right-click a label to open the associated viewport label menus. The viewport 

label menus let you change the viewport settings. 

 

Viewport label menus 

1. General menu 

2. Point-Of-View (POV) menu 

3. Shading menu 

Dynamic Resizing of Viewports 

www.a2zpapers.com
We provide GNDU question papers, PTU question papers, PU question papers, LPU question papers, GNA university question papers, PSEB question papers, HPSEB question papers, ICSE question papers and CBSE question papers.

a2zpapers.com

a2zpapers.com

a
2
z
p
a
p
e
r
s
.
c
o
m

a
2
z
p
a
p
e
r
s
.
c
o
m

a2zpapers.com

../../../../../../3dmax%20help/index.html#!/url=./files3dsmaxhelp/GUID-BE30312F-5765-4BE1-9890-8CD5CAA4EFE5.htm
a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com


You can resize the four viewports so they are of unequal proportions. To do so, drag the intersection of 

two, three, or four viewports, on the splitter bars. To return to the original layout, right-click an 

intersection of the dividing lines and choose Reset Layout from the right-click menu. 

The new viewport proportions are saved in the scene. However, changing the viewport layout always 

resets them. 

World-Space Tripod 

 

The three-color world-space tripod is visible in the lower-left corner of each viewport. The colors 

correspond to the three axes of world space: red=X, green=Y, and blue=Z. The axes are labeled in these 

same colors. The tripod always refers to world space, regardless of the current reference coordinate 

system. 

The world-space tripod is on by default. To turn off this feature, see “To turn off the world-space tripod in 

all viewports” in the following procedures. 

Viewport Tooltips for Object Names 

When you’re working with objects in a viewport and pause the cursor over any unselected object, a tooltip 

appears with the name of that object. If you need to select something or link to something, wait until you 

see the tooltip to be sure you have selected the object you want. These tooltips are disabled when you 

work in sub-object mode. 

Tooltips are on by default. To turn off this feature, see To turn off object name tooltips, below. For more 

information see Viewport Navigation and The 3ds Max Window. 

Procedures 

To make a viewport active, do one of the following: 

 Click any viewport. 

If you click an object in the viewport, it is selected. If you click a space where there are no objects, any 

selected objects are deselected. 

 Right-click any viewport. 

Right-clicking activates a viewport without changing the selection state of objects. (You can also do this 

by left-clicking the viewport label.) 

 Use  (Windows/Start) +  to cycle among the current viewports. 

To switch between single and multiple viewports, do one of the following: 

 Activate the viewport to minimize or maximize, then, on the keyboard, press +W. 

 Click  (Maximize Viewport Toggle) in the lower-right corner of the 3ds Max window. 

To change viewports when one is maximized: 

1. Press and hold  (Windows/Start), then press and release . 

This opens the viewport-switching interface. 

2. If necessary, press  repeatedly to highlight the desired viewport, then release  to 

maximize the highlighted viewport. 

Alternatively, simply click the desired viewport. 

To resize the viewports: 

1. Drag the intersection of two, three, or four viewports to move the horizontal and vertical splitter 

bars. 
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2. Move the intersection to any new location. 

If you don't drag a corner, you can move the borders horizontally or vertically only. 

3. To reset the viewports, right-click an intersection and choose Reset Layout from the right-click 

menu. 

To change the number of viewports and their arrangement: 

1. In any viewport, click or right-click the General viewport label ([+]). 3ds Max opens the General 

viewport label menu. Choose Configure. 

2. On the Viewport Configuration dialog, click the Layout tab. 

3. Choose a layout from the choices at the top of the dialog. 

4. Assign what each viewport will display in the lower window of the dialog by clicking or right-clicking 

a viewport representation and choosing from the right-click menu. 

5. Click OK to make the change. 

To turn off the world-space tripod in all viewports: 

1. Choose Customize menu  Preferences to display the Preferences dialog. 

2. Click the Viewports tab. 

3. In the Viewport Parameters group, turn off Display World Axis. 

4. Click OK to make the change. 

To turn off object-name tooltips: 

1. Choose Customize menu  Preferences to display the Preferences dialog. 

2. Click the General tab. 

3. In the UI Display group, turn off Enable Viewport Tooltips. 

4. Click OK to make the change. 

Related Information 

 Viewport Configuration 

 Viewport Label Menus 

Definations 

 Viewport Label Menus 

In the upper-left corner of each viewport is a label bar that consists of three labels. Each label is a 

clickable shortcut menu to control viewport display. 

 Viewport Navigation 

At the right end of the status bar are the buttons that control the display and navigation of the 

viewports. 
 

Scene Explorer 
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Scene Explorer provides a modeless dialog for viewing, sorting, filtering, and selecting objects in 3ds Max, 

as well as additional functionality for renaming, deleting, hiding, and freezing objects, creating and 

modifying object hierarchies, and editing object properties en masse. 

 Standard menu: Tools Menu  New Scene Explorer 

 Standard menu: Tools menu  Open Explorer: [name of most recently used explorer] 

 Standard menu: Tools menu  Saved Scene Explorers  Choose a saved scene explorer. 

 Enhanced menu: Scene menu  Manage Scene Content  New Scene Explorer 

 Enhanced menu: Scene menu  Manage Scene Content  Open Explorer: [Last Used] 

 Enhanced menu: Scene menu  Recent Scene Explorers submenu 

The Scene Explorer interface consists of a menu bar, toolbars, and a table view of objects in the scene, with 

a row for each object and a column for each displayed object property. The default layout in 3ds 

Max displays only object names, while in 3ds Max Design it also shows colors and several other properties. 

You can customize the layout to show additional properties. You can save customized Scene Explorer 

setups, and use any custom setup as the default. 

 

IMPORTANT:Autodesk 3ds Max 2015 brings a number of significant revisions to Scene Explorer, such as 

the ability to dock the dialog and revamped context menus. Each workspace now includes a default, 

docked Scene Explorer called the workspace Scene Explorer (see following for details). Also, Scene Explorer 

can now switch between two different modes: listing the scene contents by object hierarchy or by layer. 

Both modes provide drag-and-drop functionality for editing hierarchies and layers. 

To switch between the two Scene Explorer modes, use the buttons on the Selection toolbar: 

 

  - Sets Scene Explorer to Sort By 

Layer. This replaces the Layer Manager 

feature, which has been retired. 

Features are covered in this section 

and in the Using Layers to Organize a 

Scene section. 

  - Sets Scene Explorer to Sort By 

Hierarchy. This is the legacy grouping method. Features are covered in this section. 

 

Left: Scene Explorer set to Sort By Hierarchy 

Right: Scene Explorer set to Sort By Layer 

Workspace Scene Explorers 

Each workspace in 3ds Max includes a different Scene Explorer, with the name "Scene Explorer - [name of 

workspace]", docked to the left of the viewports. For specific information about its operation, 

see Workspace Scene Explorer. 

www.a2zpapers.com
We provide GNDU question papers, PTU question papers, PU question papers, LPU question papers, GNA university question papers, PSEB question papers, HPSEB question papers, ICSE question papers and CBSE question papers.

a2zpapers.com

a2zpapers.com

a
2
z
p
a
p
e
r
s
.
c
o
m

a
2
z
p
a
p
e
r
s
.
c
o
m

a2zpapers.com

../../../../../../3dmax%20help/index.html#!/url=./files3dsmaxhelp/GUID-CC462067-0788-4EB2-ACE9-D3897085E5F3.htm
../../../../../../3dmax%20help/index.html#!/url=./files3dsmaxhelp/GUID-12DA4CA4-95D4-4B06-8AFC-B3F3E9AD55D1.htm#WS1A9193826455F5FF-4855151011E22F62443251C
../../../../../../3dmax%20help/index.html#!/url=./files3dsmaxhelp/GUID-6AE0D1B1-C212-48AB-9CE0-B3214C72B3ED.htm
../../../../../../3dmax%20help/index.html#!/url=./files3dsmaxhelp/GUID-6AE0D1B1-C212-48AB-9CE0-B3214C72B3ED.htm
../../../../../../3dmax%20help/index.html#!/url=./files3dsmaxhelp/GUID-6AE0D1B1-C212-48AB-9CE0-B3214C72B3ED.htm
../../../../../../3dmax%20help/index.html#!/url=./files3dsmaxhelp/GUID-CC462067-0788-4EB2-ACE9-D3897085E5F3.htm
../../../../../../3dmax%20help/index.html#!/url=./files3dsmaxhelp/GUID-CC462067-0788-4EB2-ACE9-D3897085E5F3.htm#SECTION_746FBAEA910D46CE870BD094A2DF4CB5
a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com
www.a2zpapers.com


 

Workspace Scene Explorer (red outline) docked in 3ds Max interface 

Multiple Scene Explorers 

For many workflows, the single Scene Explorer included in each workspace will suffice. However, if you 

need to use additional explorers (for example, to list different types of scene elements), you can open a 

new Scene Explorer dialog with either of the New Scene Explorer commands listed at the start of this topic. 

Each subsequent invocation of this command opens a separate, additional Scene Explorer dialog. All Scene 

Explorers persist in the scene, even if closed. With the standard menu system active, you can open the 

most recently used Scene Explorer with the Tools menu  Open Explorer command, or any Scene Explorer 

with the Tools menu  Saved Scene Explorers submenu. And with the enhanced menu system active, you 

can open existing Scene Explorers with the Scene menu  Manage Scene Content  Open Explorer 

command and the Recent Scene Explorers submenu. 

TIP:In a new scene, the keyboard shortcut + + O (letter O) creates a new Scene Explorer. But 

when one or more Scene Explorers exist in the scene, the same shortcut opens the most recently used 

Explorer. 

All active Scene Explorers are saved and loaded with the scene. To save and load Scene Explorers 

separately, and delete and rename them, use Manage Scene Explorer. 

Scene Explorer Features 

Following are additional notable features of Scene Explorer: 

 Customize the dialog by setting any configuration of columns, hidden and displayed categories (via 

the left-hand toolbar), and so on. 

 Open as many separate instances of the dialog as you like, each with a different configuration. 
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  Switch the display between hierarchy mode and layer mode (see preceding). 

  Nest layers to any depth. 

  Selection is automatically synchronized between Scene Explorer and the scene: Select 

an object in the viewport and it automatically highlights in Scene Explorer, and vice-versa. 

  Dock the dialog right or left by dragging and dropping or by right-clicking the title bar and 

choosing the Dock location. 

  Toggle object and layer visibility by clicking the light bulb icon. 

 

NOTE:The light bulb icon has no connection 

with scene lighting; it merely denotes 

whether an object or layer is visible (yellow) 

or not (gray). 

  You can now 

see group members in Scene Explorer (Sort By Hierarchy mode only) without having to open the group. 

As with hierarchies and layers, you expand and collapse each group by clicking the arrow next to its 

name. 

 Save and load different configurations. See Manage Scene Explorer. 

 Set any configuration as the default. See Manage Scene Explorer. 

 Scene Explorer setup is saved with your MAX scene file. 

 Create and edit object hierarchies and layer groups by dragging and dropping. 

 Sort on single or multiple columns. 

 Change object settings singly or en masse. 

 Powerful, sophisticated search and filtering features. 

Scene Explorer Variants 

Several specialized versions of Scene Explorer are available in different areas of 3ds Max. They provide 

column and toolbar setups appropriate for working in specific areas of 3ds Max. These include: 

 Container Explorer 

 MassFX Explorer 

 Material Explorer 

Several additional custom Scene Explorer setups are available from the Add Default Scene Explorer 

submenu on the View toolbar drop-down list. These include explorers designed for working with lights, 

objects with missing plug-ins, and more. Last, the Select From Scene command and its variants use a modal 

dialog dedicated to selecting from a text-based list; it has no editing functions. 
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Definations: 

 Using Scene Explorer-This topic includes procedures for using general functionality in the Scene Explorer 

window. You can find additional procedures for specific Scene Explorer features in Scene Explorer 

Columns, Advanced Search Dialog (Scene Explorer), and Advanced Filter Dialog (Scene Explorer). 

 Using Layers to Organize a Scene-Layers are like transparent overlays on which you organize and group 

different kinds of scene information. The objects you create have common properties including color, 

renderability, and display. Layers have these properties as well, and the objects they contain can inherit the 

properties from their layer. 

 Scene Explorer Columns-The Scene Explorer columns provide information on and means to edit various 

properties of scene contents in 3ds Max. These include text strings, checkboxes, numeric quantities, and more. 

You can also sort the Scene Explorer listing by clicking a column heading (a second click reverses the sort). 

Additional methods for using columns are available; see the Procedures section that follows. 

 Scene Explorer Menus-The principal Scene Explorer menus are available on the dialog menu bar. In 

addition, several context menus are available by right-clicking different user-interface elements on the dialog. 

 Scene Explorer Toolbars-The Scene Explorer has various toolbars for finding and selecting items and 

setting display filters. By default these are displayed as upper and lower toolbars. Additional toolbars are 

available to the left of the table. 

 Manage Scene Explorer-Whenever you open a Scene Explorer (Container Explorer, etc.) dialog, it remains 

available for subsequent usage for the life of the scene, even if you close it. Use the Manage Scene Explorer 

dialog to open, save, and load custom Scene Explorers, delete and rename existing instances, and set your 

favorite Scene Explorer configuration as the default. 

 Advanced Search Dialog (Scene Explorer)-The Advanced Search dialog lets you highlight objects in the 

Scene Explorer list using combinations of search phrases to specify Boolean searches. For example, you can use 

Advanced Search to select only hidden non-geometry objects of a specific color whose name begins with “S”. 

 Advanced Filter Dialog (Scene Explorer)-The Advanced Filter dialog lets you limit object display in Scene 

Explorer based on combinations of filter conditions (filter phrases). That is, you can use it to hide all objects 

that don't meet the filter criteria. For example, you can use Advanced Filter to list only hidden non-geometry 

objects of a specific color whose name begins with “S”. 
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